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Chapter 316 

Tests for Two 
Between Variances in 
a Replicated Design 
Introduction 
This procedure calculates power and sample size of tests of the between-subject variance (between + within) from a 
parallel (two-group) design with replicates (repeated measures) for the case when the ratio assumed by the null 
hypothesis is one. This is the common case. This routine expresses the effect size in terms of the ratio of the 
between-subject variances.  

A parallel design is used to compare two treatment groups by comparing subjects receiving each treatment. In this 
replicated design, each subject is measured M times where M is at least two. To be clear, each subject receives only 
on treatment, but is measured repeatedly. 

Replicated parallel designs such as this are popular because they allow the assessment of total variances, between-
subject variances, and within-subject variances. 

It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout 
period between measurements.  

Technical Details 
This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 209 - 212. 

Suppose 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖  is the response of the ith treatment (i = T, C), jth subject (j = 1, …, Ni), and kth replicate (k = 1, …, M). 
The model analyzed in this procedure is 

𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑖𝑖 + 𝑆𝑆𝑖𝑖𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖 

where 𝜇𝜇𝑖𝑖 is the treatment effect, 𝑆𝑆𝑖𝑖𝑖𝑖 is the random effect of the jth subject in the ith treatment, and 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖 is the within-
subject error term which is normally distributed with mean 0 and variance 𝑉𝑉𝑖𝑖 = 𝜎𝜎𝑊𝑊𝑊𝑊

2 .  

Unbiased estimates of these variances are given by 

𝜎𝜎�𝑊𝑊𝑊𝑊
2 = 𝑠𝑠𝑊𝑊𝑊𝑊

2 =
1

𝑁𝑁𝑖𝑖(𝑀𝑀− 1)
���𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑥̅𝑥𝑖𝑖𝑖𝑖. �2

𝑀𝑀

𝑘𝑘=1

𝑁𝑁𝑖𝑖

𝑗𝑗=1

 , 𝑖𝑖 = 𝑇𝑇,𝐶𝐶 
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where 

𝑥̅𝑥𝑖𝑖𝑖𝑖. =
1
𝑀𝑀
�𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

𝑀𝑀

𝑘𝑘=1

 

Define 

𝑠𝑠𝐵𝐵𝐵𝐵2 =
1

𝑁𝑁𝑖𝑖 − 1
��𝑥̅𝑥𝑖𝑖𝑖𝑖. − 𝑥̅𝑥𝑖𝑖..�

2
𝑁𝑁𝑖𝑖

𝑗𝑗=1

  

where 

𝑥̅𝑥𝑖𝑖.. =
1
𝑁𝑁𝑖𝑖
�𝑥̅𝑥𝑖𝑖𝑖𝑖.

𝑁𝑁𝑖𝑖

𝑗𝑗=1

 

Now, estimators for the between-subject variance are given by 

𝜎𝜎�𝐵𝐵𝐵𝐵2 = 𝑠𝑠𝐵𝐵𝐵𝐵2 −
1
𝑀𝑀
𝜎𝜎�𝑊𝑊𝑊𝑊
2  

Testing Variance Inequality  
The following three sets of statistical hypotheses are used to test for between-subject variance inequality with a 
non-unity null 

𝐻𝐻0 : 
𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
≥ 1 versus 𝐻𝐻1 : 

𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
< 1, 

𝐻𝐻0:
𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
≤ 1 versus 𝐻𝐻1 : 

𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
> 1, 

𝐻𝐻0 : 
𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
= 1 versus 𝐻𝐻1 : 

𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
≠ 1.  

Let 𝜂𝜂 = 𝜎𝜎𝐵𝐵𝐵𝐵2 − (𝜎𝜎𝐵𝐵𝐵𝐵2 ) be the parameter of interest. The test statistic is 𝜂̂𝜂 = 𝜎𝜎�𝐵𝐵𝐵𝐵2 − (𝜎𝜎�𝐵𝐵𝐵𝐵2 ). 

Two-Sided Test 
For the two-sided test, compute two limits, 𝜂̂𝜂𝐿𝐿 and 𝜂̂𝜂𝑈𝑈, using 

𝜂̂𝜂𝐿𝐿 = 𝜂̂𝜂 − �Δ𝐿𝐿 

𝜂̂𝜂𝑈𝑈 = 𝜂̂𝜂 +�Δ𝑈𝑈 

Reject the null hypothesis if  𝜂̂𝜂𝐿𝐿 > 0 is or 𝜂̂𝜂𝑈𝑈 < 0. 

The Δ𝑠𝑠 are given by 

Δ𝐿𝐿 = ℎ �
𝛼𝛼
2

,𝑁𝑁𝑇𝑇 − 1� 𝑠𝑠𝐵𝐵𝐵𝐵4 + ℎ �1 −
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2
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�
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where 

ℎ(𝐴𝐴,𝐵𝐵) = �1−
𝐵𝐵
𝜒𝜒𝐴𝐴,𝐵𝐵
2 �

2

 

and 𝜒𝜒𝐴𝐴,𝐵𝐵
2  is the upper quantile of the chi-square distribution with B degrees of freedom. 

One-Sided Test 
For the lower, one-sided test, compute the limit, 𝜂̂𝜂𝑈𝑈, using 

𝜂̂𝜂𝑈𝑈 = 𝜂̂𝜂 +�Δ𝑈𝑈 

Reject the null hypothesis if  𝜂̂𝜂𝑈𝑈 < 0. 

The Δ𝑈𝑈 is given by 

Δ𝑈𝑈 = ℎ(1 − 𝛼𝛼,𝑁𝑁𝑇𝑇 − 1)𝑠𝑠𝐵𝐵𝐵𝐵4 + ℎ(𝛼𝛼,𝑁𝑁𝐶𝐶 − 1)𝑠𝑠𝐵𝐵𝐵𝐵4 + ℎ�𝛼𝛼,𝑁𝑁𝑇𝑇(𝑀𝑀− 1)� �
𝑠𝑠𝑊𝑊𝑇𝑇
2

𝑀𝑀
�
2

+ ℎ�1 − 𝛼𝛼,𝑁𝑁𝐶𝐶(𝑀𝑀− 1)� �
𝑠𝑠𝑊𝑊𝑊𝑊
2

𝑀𝑀
�
2

 

Power 

Two-Sided Test 
The power of the two-sided test assuming 𝑛𝑛 = 𝑁𝑁𝑇𝑇 = 𝑁𝑁𝐶𝐶 is given by 

Power = 1 −Φ�𝑧𝑧1−𝛼𝛼2
−

(𝑅𝑅1 − 1)𝜎𝜎𝑇𝑇𝑇𝑇2

�𝜎𝜎∗2/𝑛𝑛
�+Φ�𝑧𝑧𝛼𝛼/2 −

(𝑅𝑅1 − 1)𝜎𝜎𝑇𝑇𝑇𝑇2

�𝜎𝜎∗2/𝑛𝑛
� 

where 

𝑅𝑅1 =
𝜎𝜎𝐵𝐵𝐵𝐵2

𝜎𝜎𝐵𝐵𝐵𝐵2
 

𝜎𝜎𝐵𝐵𝐵𝐵2 = 𝑅𝑅1𝜎𝜎𝐵𝐵𝐵𝐵2  

𝜎𝜎∗2 = 2 ��𝜎𝜎𝐵𝐵𝐵𝐵2 +
𝜎𝜎𝑊𝑊𝑊𝑊
2

𝑀𝑀 �
2

+ �𝜎𝜎𝐵𝐵𝐵𝐵2 +
𝜎𝜎𝑊𝑊𝑊𝑊
2

𝑀𝑀 �
2

+
𝜎𝜎𝑊𝑊𝑊𝑊
4

𝑀𝑀2(𝑀𝑀− 1) +
𝜎𝜎𝑊𝑊𝑊𝑊
4

𝑀𝑀2(𝑀𝑀 − 1)� 

where R1 is the value of the variance ratio stated by the alternative hypothesis and Φ(𝑥𝑥) is the standard normal 
CDF. 

A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary 
sample size. 

One-Sided Test 
The power of the lower, one-sided test, 𝐻𝐻0 : 𝜎𝜎𝐵𝐵𝐵𝐵

2

𝜎𝜎𝐵𝐵𝐵𝐵
2 ≥ 1 versus 𝐻𝐻1: 𝜎𝜎𝐵𝐵𝐵𝐵

2

𝜎𝜎𝐵𝐵𝐵𝐵
2 < 1,  is given by 

Power = Φ�𝑧𝑧𝛼𝛼 −
(𝑅𝑅1 − 1)𝜎𝜎𝐵𝐵𝐵𝐵2

�𝜎𝜎∗2/𝑛𝑛
� 
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The power of the upper, one-sided test, 𝐻𝐻0 : 𝜎𝜎𝐵𝐵𝐵𝐵
2

𝜎𝜎𝐵𝐵𝐵𝐵
2 ≤ 1 versus 𝐻𝐻1 : 𝜎𝜎𝐵𝐵𝐵𝐵

2

𝜎𝜎𝐵𝐵𝐵𝐵
2 > 1,  is given by 

Power = 1 −Φ�𝑧𝑧1−𝛼𝛼 −
(𝑅𝑅1 − 1)𝜎𝜎𝐵𝐵𝐵𝐵2

�𝜎𝜎∗2/𝑛𝑛
� 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and 
power. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will 
select either Power or Sample Size. 

Test Direction 

Alternative Hypothesis 
Specify whether the alternative hypothesis of the test is one-sided or two-sided.  

Note that this parameter impacts the value of alpha. The value of alpha is used directly for one-sided tests. For 
two-sided tests, alpha is replaced by alpha/2. 

Two-Sided Hypothesis Test 
H0: σ²вᴛ/σ²вᴄ = 1 vs. H1: σ²вᴛ/σ²вᴄ ≠ 1 

One-Sided Hypothesis Tests 
Lower:   H0: σ²вᴛ/σ²вᴄ ≥ 1 vs. H1: σ²вᴛ/σ²вᴄ < 1 

Upper:   H0: σ²вᴛ/σ²вᴄ ≤ 1 vs. H1: σ²вᴛ/σ²вᴄ > 1 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  
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Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size  

Sample Size Per Group 
The Sample Size Per Group is the number of items or individuals sampled in a group. Since the sample sizes are 
the same in each group, this value is the value for NT and NC. 

The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values. 

M (Measurements Per Subject) 
Enter one or more values for M: the number of repeated measurements per subject. All measurements are for the 
same treatment. 

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1. 

The range is M ≥ 2. 

Effect Size 

R1 (Actual Variance Ratio) 
Enter one or more values for between-subject variance ratio assumed by the alternative hypothesis. This is the 
value of σ²вᴛ / σ²вᴄ at which the power is calculated. 

The range of possible values is R1 > 0. R1 ≠ 1. 

σ²вᴄ (Control Variance) 
Enter one or more values for the between-subject variance of the control measurements. This value will have to be 
determined from a previous study or a pilot study. 

The range of possible values is σ²вᴄ > 0.  

σ²ᴡᴛ (Treatment, Within-Subject Variance) 
Enter one or more values for within-subject variance of the treatment measurements. This value will have to be 
determined from a previous study or a pilot study. 

The range of possible values is σ²ᴡᴛ > 0.  

σ²ᴡᴄ (Control, Within-Subject Variance) 
Enter one or more values for within-subject variance of the control measurements. This value will have to be 
determined from a previous study or a pilot study. 

The range of possible values is σ²ᴡᴄ > 0.  
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Example 1 – Finding Sample Size 
A company has developed a generic drug for treating rheumatism and wants to compare it to the standard drug in 
terms of the between-subject variability. A two-group, parallel design with replicates will be used to test the 
inequality using a two-sided test.  

Company researchers set the significance level to 0.05, the power to 0.90, M to 2, and the actual variance ratio 
values between 0.5 and 1.3. They also set σ²вᴄ = 0.8, σ²ᴡᴛ = 0.2, and σ²ᴡᴄ = 0.3. They want to investigate the 
range of required sample size values assuming that the two group sample sizes are equal. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Tests for Two Between Variances in a Replicated Design procedure window. You may then 
make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alternative Hypothesis ............................ Two-Sided (H1: σ²вᴛ/σ²вᴄ ≠ 1) 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
M (Measurements Per Subject) .............. 2 
R1 (Actual Variance Ratio) ..................... 0.5 0.7 0.9 1.1 1.3 
σ²вᴄ (Control Variance) .......................... 0.8 
σ²ᴡᴛ (Treatment Variance) ..................... 0.2 
σ²ᴡᴄ (Control Variance) .......................... 0.3 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

 
Numeric Results ──────────────────────────────────────────────────────────── 
H0: σ²вᴛ/σ²вᴄ = 1 vs. H1: σ²вᴛ/σ²вᴄ ≠ 1 
 
      Betw Wthn Wthn  
 Grp T Grp C   Actual Subj Subj Subj  
 Sample Sample  Num Var Var Var Var  
Actual Size Size  Reps Ratio Cntl Trt Cntl  
Power Nᴛ Nᴄ N M R1 σ²вᴄ σ²ᴡᴛ σ²ᴡᴄ Alpha 
0.9007 156 156 312 2 0.500 0.800 0.200 0.300 0.050 
0.9005 501 501 1002 2 0.700 0.800 0.200 0.300 0.050 
0.9001 5279 5279 10558 2 0.900 0.800 0.200 0.300 0.050 
0.9000 6224 6224 12448 2 1.100 0.800 0.200 0.300 0.050 
0.9003 816 816 1632 2 1.300 0.800 0.200 0.300 0.050 
 
References 
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third 
   Edition. Taylor & Francis/CRC. Boca Raton, Florida. 
Chow, S.C. and Liu, J.P. 2014. Design and Analysis of Clinical Trials, Third Edition. John Wiley & Sons. 
   Hoboken, New Jersey. 
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Report Definitions 
Actual Power is the actual power achieved. Because Nᴛ and Nᴄ are discrete, this value is usually slightly 
   larger than the target power. 
Nᴛ is the number of subjects in the treatment group. 
Nᴄ is the number of subjects in the control group. 
N is the total number of subjects. N = Nᴛ + Nᴄ. 
M is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a 
   subject. 
R1 is the value of the between-subject variance ratio at which the power is calculated. 
σ²вᴄ is the between-subject variance of measurements in the control group. Note that σ²ᴛᴄ = σ²вᴄ + σ²ᴡᴄ. 
σ²ᴡᴛ is the within-subject variance of measurements in the treatment group. 
σ²ᴡᴄ is the within-subject variance of measurements in the control group. 
Alpha is the probability of rejecting a true null hypothesis, H0. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
A study is being conducted to compare the between-subject variance of a treatment group to a 
control group using a two-sided hypothesis test of data from a replicated parallel design. 
Group sample sizes of 156 and 156 achieve 90% power to reject the null hypothesis at a 
significance level of 0.050. The variance ratio assumed by the null hypothesis is 1.0. The 
variance ratio at which the power is calculated is 0.500. The number of times the measurement 
is repeated on a subject is 2. The actual between-subject variance of the control group is 
assumed to be 0.800. The actual within-subject variance of the treatment group is assumed to be 
0.200. The actual within-subject variance of the control group is assumed to be 0.300. 
 

This report gives the sample sizes for the indicated scenarios.  

Plot Section 
 

  
 

This plot shows the relationship between sample size and R1. 
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Example 2 – Validation using PASS 
We will use an example from a previously validated PASS procedure to validate this procedure. The previously 
validated procedure is Non-Unity Null Tests for Two Between Variances in a Replicated Design. 

For this example, if in the other procedure we set power = 0.8, R0 = 1, significance level = 0.05, M = 3, R1 = 
0.52, σ²вᴄ = 0.25, σ²ᴡᴛ = 0.04, σ²ᴡᴄ = 0.09, the resulting per group sample size is 109.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Tests for Two Between Variances in a Replicated Design procedure window. You may then 
make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alternative Hypothesis ............................ Two-Sided (H1: σ²вᴛ/σ²вᴄ ≠ 1) 
Power ...................................................... 0.80 
Alpha ....................................................... 0.05 
M (Measurements Per Subject) .............. 3 
R1 (Actual Variance Ratio) ..................... 0.52 
σ²вᴄ (Control Variance) .......................... 0.25 
σ²ᴡᴛ (Treatment Variance) ..................... 0.04 
σ²ᴡᴄ (Control Variance) .......................... 0.09 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

 
Numeric Results ──────────────────────────────────────────────────────────── 
H0: σ²вᴛ/σ²вᴄ = 1 vs. H1: σ²вᴛ/σ²вᴄ ≠ 1 
 
      Betw Wthn Wthn  
 Grp T Grp C   Actual Subj Subj Subj  
 Sample Sample  Num Var Var Var Var  
Actual Size Size  Reps Ratio Cntl Trt Cntl  
Power Nᴛ Nᴄ N M R1 σ²вᴄ σ²ᴡᴛ σ²ᴡᴄ Alpha 
0.8020 109 109 218 3 0.520 0.250 0.040 0.090 0.050 
 

The sample size of 109 per group matches the expected result. 
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